
Image Viewing 
 

with ImageScope 
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ImageScope Components 
 
Use ImageScope to View These File Types: 

• ScanScope Virtual Slides – .SVS files created when the ScanScope scanner 
scans glass microscope slides. 

• JPEG files – Both .JPG and .JP2 files. 
• TIFF and TIF files. 
• CWS files – Composite WebSlides. 
• ScanScope image set, .sis file – The ImageScope image view is what you see 

when one or more digital slides are being viewed in the ImageScope window. 

Digital Slide Studio can be used to 
convert a file to .svs 
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ImageScope Components 
 
ImageScope Main Menu 

• You can access various ImageScope features from the following: 
• File:  Open/Close Images, Save Images & Snapshot and Access Remote Servers. 
• Edit: Copy. 
• Image: Adjust Image Parameters, Rotate, View Image Info, Resolution, False Color, 

Quality, Keep Open, Go to specific image X,Y coordinates. 
• View:  Scale Axes/Grid, Viewing Tools (Magnifier, Thumbnail etc.) Status Bar, 

Annotations and Annotations Links, Analysis tool, Tracking tool, Digital Slide 
Conferencing and TelePath Live (remote live viewing of a slide). 

• Tools:  Options (allows user to customize ImageScope features), Advanced (adjust 
Image Cache parameters), Logging (turns on/off logging of ImageScope actions). 

• Windows:  Changes view of images to tile horizontal/vertical or cascade. 
• Help:  ImageScope Help, Send Feedback (to Aperio), ImageScope Version Info. 
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ImageScope Components 
 
 ImageScope Tool Bar Summary 
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ImageScope Basic Features 
 
ImageScope Tools/Menus 

• The Slide barcode or Spectrum slide ID can be seen in the Title Bar. 
• The Main menu is at the top of the window below the title bar.  
• The Main Toolbar is below the main menu. 

Main Menu 

Main 
Toolbar 

Title Bar 
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ImageScope Basic Features 
 
Keyboard Shortcuts 

• Keyboard shortcuts can be used with ImageScope.  
• Help – F1 
• Pen drawing tool – F2 
• Negative pen drawing tool – F3 
• Ruler – F4 
• Rectangle drawing tool – F5 
• Ellipsis drawing tool – F6 
• Arrow drawing tool – F7 
• View full screen – F11 
• Open image rotation toolbar – Ctrl E 
• View/hide Analysis – Ctrl G 
• Keep Open – Ctrl K 
• View/hide Annotations – Ctrl N 
• Display IQ toolbar – Ctrl Q 
• View/hide thumbnail – Ctrl T 
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ImageScope Basic Features 
 
Open Digital Slides 

• Open a single digital slide or multiple slides from the Spectrum web interface. 

- OR - 

Open a single 
digital slide. 

Open multiple 
digital slides. 
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ImageScope Basic Features 
 
Open Digital Slides. 

• Open a Spectrum digital slide directly in ImageScope by accessing the remote 
ImageServer. 

Access remote 
ImageServer via 

ImageScope 
main menu. 

When opening an image via the 
remote ImageServer, you will need 
to log in using your Spectrum 
username and password to 
validate that you have the proper 
user permissions. 
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ImageScope Basic Features 
 
Open Digital Slides 

• Open local digital slides; that is, images that reside on your workstation. 
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ImageScope Basic Features 
 
ImageScope Hide/View 

• View/hide various ImageScope features from the View Menu. 
• Items checked = Display 
• Unchecked  = Hidden 
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ImageScope Basic Features 
 
ImageScope Viewing Options 

• The thumbnail displays where 
you are in the image at a higher 
power (represented by rectangle). 
Click in thumbnail to navigate 
anywhere in slide. 

• The filmstrip will display multiple 
selected images. The current slide 
has a bold border. 

• Magnifier:   Left click and drag in 
the magnified area to move the 
magnifier to any location. 

 
Filmstrip 

Thumbnail 

Magnifier 
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ImageScope Basic Features 
 
ImageScope Pan 

• Pan using hand.  
• Auto Pan using arrow (hand changes to an arrow when close to image edge).  

 

Click & 
Drag 

Left Click 
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ImageScope Basic Features 
 
ImageScope Zoom 

• Mouse scroll wheel will zoom in and 
out. 

• Zoom tool changes the zoom on the 
image. 

• Double clicking anywhere in the 
image or thumbnail takes you to the 
highest zoom of that area. 

• Zoom Navigation allows user to define 
the zoom in window exactly. 

 

Double click 
to Zoom 

Scroll to Zoom 

Select to Zoom 

Define Zoom 
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ImageScope Basic Features 
 
ImageScope Rotation 

• Rotate an image for display.  
• Rotation setting is not saved with the image when the image is closed. 

• Create/save a new rotated image using the Snapshot or Extract Region tools. 
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ImageScope Sync Viewing 
 
Synchronized Navigation of Multiple Digital Slides  
 
 
 

 Synchronization 
• Manually align multiple slides to view common regions, then click the 

synchronization icon to lock them in for synchronized viewing (i.e., if you pan 
right in one slide, the other digital slides also pan right).  

 Smart Synchronization  
• Smart synchronization is an extension of the synchronization feature.  It 

automatically aligns multiple slides to a common region and locks them in for 
synchronized viewing. 

• Smart synchronization is able to compensate for rotation (non-flipped) but not for 
other factors such as stretched or missing tissue. In those cases, ImageScope will 
do its best to display the same tissue feature in all tiled images, but not 
necessarily in exactly the same location. 

Synchronization Smart Synchronization 
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ImageScope Sync Viewing 
 
Viewing Multiple Slides 

Simultaneously 
• Click Window Menu and select 

Tile Horizontal. 
• Click Sync           .   

• Smart Sync 
• Slides should synchronize 

automatically to the same 
region within in the digital 
images. 

• Smart sync is dependant upon 
slide to slide similarity in shape, 
size and form. 

• Manual Sync 
• Manually orient slides to 

desired location prior to 
synchronizing. 
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ImageScope Annotations 
 
Annotation Tools 

• Point to, highlight, measure, 
outline or exclude areas with 
annotation tools. 
 

Pen * 
Negative Pen*(excludes area) 
Ruler (measures in microns) 
Rectangle* 
Ellipse 
Arrow 

 
*These annotation tools  
can be used to define regions to  
perform or exclude Image Analysis.  
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ImageScope Annotations 
 
Annotation Layers and Regions 

• Layers: Annotations that are grouped and color coded in the annotations 
window.  

• Layer Regions:  Each object within a layer (i.e.: a pen outline and comments). 
 

Layers Layer Regions 

Layer 1522 
(green),  
Region 2 is 
currently 
selected. 

Current selected region 
(annotation) will have a 
bolded black centerline 
to distinguish it from 
another annotations. 
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ImageScope Annotations 
 
Annotation Layer and Region Toolbars 

• Save, view/hide, change color, add new, export, delete or delete all 
Layers/Regions. 

Layers 
Layer 

Regions 
Layer Attributes 

View/Hide  

Color 

Add Layer/Region/Attribute 

Delete Attribute 

Delete Layer/Region 

Delete All Layers 

Save Annotations 

Export Grid to Text File  

Export Grid to Excel File  
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ImageScope Annotations  
 
Annotations Summary View 

• Provides a streamed line view of the annotations window. 
• Developed for analyzing DIHC slides. 
• Makes the process quicker and simpler by fitting into a normal workflow. 

Click to return to detailed 
annotations window. 

If slide specific processing 
is enabled and set to use a 
specific IA macro, the tool 
will populate here.  

Analysis outputs. 

Navigate to 
annotations that 
have been drawn. 

The summary view 
is the default view 
for the clinical DIHC 
workflow.  
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ImageScope Image Analysis 
 
Define Image Analysis Area 

• Image Analysis can be performed on an entire image or on user defined regions. 
    Pen  
     Negative Pen  
     Rectangle 

Use either the Pen or 
Rectangle to annotate a 
region of analysis (if not 
doing whole slide analysis). 
Use the Negative Pen to 
exclude areas from being 
analyzed.  

Pen = Solid Line 

Negative Pen = Dashed Line 

Pen Outline 
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ImageScope Image Analysis 
 
Select Area to Analyze 

• Analyze an entire digital slide image or use the annotation tools to pick just an 
area to analyze.  

• Open the Annotations window from the view menu. 
• Select Annotation Layer and Region to analyze (skip this step if doing whole 

slide analysis). 
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ImageScope Image Analysis 
 
Perform Analysis 

•  Select analysis tool to use with a slide through the Analysis window. 
• Macros are sets of Image Analysis parameters defined to meet a specific research or 

clinical application.  
• Macros are categorized by type (Positive Pixel Count etc.).  
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ImageScope Image Analysis 
 
Analysis Window 

• ImageScope user interface is somewhat different depending on whether you are 
analyzing a local or a remote image (client side analysis vs. server side 
analysis). 

 
 
Window from ImageScope 

 
 
Window from Spectrum 
 

Select region to be 
analyzed. 

Select region to be 
analyzed. 

Select algorithm or 
macro for analysis. 

Select algorithm or 
macro for analysis. 

Click to begin analysis. 
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ImageScope Image Analysis 
 
Analysis Results 

• When the analysis is done, the Algorithms window displays “Analysis complete.” 
• If generated, the markup image is displayed. 

• View results in the Annotations window.  

Markup Image  

Results  

If the slide is analyzed 
locally, the results are 
not saved in Spectrum, 
but are saved in an 
annotations file where 
the local file resides. 
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ImageScope Additional Tasks 
 
Keep Open Option 

• When you select one or more multiple images in Spectrum (by clicking the 
thumbnail or selecting multiple images and using the View Images command), 
any images already open in ImageScope are closed before displaying the new 
ones.  

• Use the Keep Open option to keep a specific image in ImageScope open when 
you select and view new images in Spectrum.  

Turn “keep open” on and off by typing ctrl K. 
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ImageScope Additional Tasks 
 
Scale Axes & Grid 

• View scale axes and a grid on an image in ImageScope.  
• The units and spacing are adjusted to correspond to the resolution of the image 

and the current zoom level.  

Scale Axes 
Scale Axes 

& Grid 
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ImageScope Additional Tasks 
  
SnapShot/Save Images 

• The Snapshot icon       grabs a 
screen shot of the image as it 
appears in your screen. 

• The Save Image(s) icon         
saves a link to all images in the 
filmstrip to a file.   
 

 
 

Snapshot Save Image(s) 
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ImageScope Additional Tasks 
 
Extract Region 

• Extract Region icon        will 
capture a high resolution portion 
of the image defined by the user 
dragging a box around the area of 
interest. 

• Various image formats are 
available upon saving the image. 

 
 

Extract Region 
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Image Quality 
 
Image Quality Module (IQ)  

• Provides advanced view options based on the digital slide’s stains. 
• Users can customize the view of slides visual clarity by: 

• Digitally adjusting the stain colors. 
• Viewing the individual stain images. 
• Re-mixing the stains on the fly while navigating the image.   

• IQ uses color processing, analyzing each pixel of the digital slide image, to 
identify stains and modify their appearance on the digital slide. 

IQ is available when you have opened a digital slide in 
ImageScope from Spectrum and if your site is licensed 
for Spectrum Plus.  
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Image Quality Features 
 
IQ Features 

• View a selected stain while navigating the 
slide. 

• IQ uses color deconvolution to separate stains 
and present them as you pan or scroll about the 
image. 

• Boost or dilute the displayed concentration. 
• Useful for over or under stained slides. 

• Enhance cellular detail such as nuclei. 
• Digitally adjust individual stain color for visual 

clarity and personal preferences.   
• Visual enhancements are only applied for the 

current ImageScope session and does not 
change the actual digital slide.  
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Image Quality Stain Sets 
 
IQ – Use With Any Stain Set 

• To use IQ user must open an image in ImageScope through Spectrum Plus. 
• With a digital slide open in ImageScope, clicking the IQ       button displays the 

stain set menu.  
• The Default stain set is H&E and is just a place holder.  Users need to replace the 

stain set with their personal settings for H&E. 

Pink box indicates stain set applied 

Click the      button to turn IQ on & off 
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Image Quality Viewing Stains 
 
Viewing Individual Stains 

• From the Image menu, clicking Quality displays the Image Viewing toolbar. 
• AB displays the image with both stains. 
• A displays the image with only stain A (Hematoxylin for default set). 
• B displays the image with only stain B (Eosin for the default set). 
• Details displays the entire IQ window. 

The options in this window will reflect the stain set chosen.  
For example, if the stain set included H&E and DAB the 
Quality menu options will reflect accordingly. 
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Image Quality Functions 
 
Several IQ functions allow the user 

to: 
• Define and save stains sets. 
• Change concentration. 
• Change intensity and color settings. 
• Measure color of stains used in the lab. 
• Use the tabs to navigate through IQ 

features. 
 



Page 35 

Fluorescence Grayscale Support 
 
Grayscale Image can be viewed in ImageScope 

• A grayscale image is one in which each pixel contains no color component, but 
has only a value that define its intensity from black at the weakest intensity to 
white at the strongest. 

• Often produced by measuring the intensity of light at each pixel in a single band 
of the electromagnetic Spectrum, such as fluorescence. 
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Fluorescence Grayscale Support 
 
False Color 

• Users can set a grayscale image to a false color to highlight details by increasing 
the distance in color space between successive gray levels. 

• This does not increase the information contents of the original image. 
• To assign false color: 

• From the Image menu, click False Color, the dialog box displays. 
• Select the color using the slider bar or click a specific color. 
• Click Enable to see the image in false color. 
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